The #1 way to reach 48,000 University of Maryland students, faculty, and staff!
Contents

Who are we?

2018–2019 Publication Schedule

Special Sections and Products

- Orientation Guide
- Terp Housing Guide
- Basketball Spirit Papers

Print Rates

Online Rates

Creating Your Ad

Checking Ad Size
Who Are We?

The Diamondback, the University of Maryland’s independent student-run newspaper is published by Maryland Media Inc. — a 501c3 nonprofit.

Published continuously since 1910, The Diamondback is College Park’s only newspaper and #1 source for news, sports, and entertainment. We distribute 6,000 newspapers FREE at 68 on and off campus locations, and publish online daily at DBKnews.com. The Diamondback reaches 100,000 readers each week and is regularly recognized for editorial excellence, including being named the #1 college newspaper in the country four times by the Society of Professional Journalists.

Address
Published by Maryland Media Inc.
3136 South Campus Dining Hall
College Park, MD 20742
301.314.8000

Staff
Editor-in-chief: Ryan Romano
Advertising Director: Patrick Battista
Business Manager: Craig Mummey
General Manager: Arnie Applebaum

Why Advertise with The Diamondback?

Brand Recognition
Make your business known to UMD students and increase your sales.

Website Conversions
Advertise on dbknews.com to see more people click through to your website!

Increase Sales
Adding coupons & special deals brings customers to your business.
The Diamondback's Readers

Where Do Our Readers Spend Their Money?

<table>
<thead>
<tr>
<th>Statistic</th>
<th>Amount</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Grocery Store purchases per month</td>
<td>5.9</td>
<td>5.7</td>
</tr>
<tr>
<td>Average Restaurant purchases per month</td>
<td>5.7</td>
<td>4.1</td>
</tr>
<tr>
<td>Average Bar purchases per month</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Average Drug Store purchases per month</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Students taking winter or summer term classes

Students who plan to attend a grad program

Statistics

$650 Million

The amount spent each year by College Park's students, faculty & staff

21

The Average Age of all the University of Maryland students

47,964

The total number of students at the University of Maryland

91%

The number of students, faculty & staff who read The Diamondback at least once a week

72%

Amount of student income used for dining, drinks & snacks

56%

University of MD students with a paid job

36%

University of Maryland students who are from Out-of-State

Source: MMG Advertising, March 2018
## 2018–2019 Print & Digital Publication Schedule

<table>
<thead>
<tr>
<th>Publication Date</th>
<th>Feature</th>
<th>Deadline</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday, August 27, 2018</td>
<td>Welcome Back / Football Preview</td>
<td>Wednesday, August 22, 2018</td>
</tr>
<tr>
<td>Tuesday, September 4, 2018</td>
<td>(Monday is Labor Day)</td>
<td>Wednesday, August 29, 2018</td>
</tr>
<tr>
<td>Monday, September 10, 2018</td>
<td></td>
<td>Wednesday, September 5, 2018</td>
</tr>
<tr>
<td>Monday, September 17, 2018</td>
<td>Family Weekend Issue</td>
<td>Wednesday, September 12, 2018</td>
</tr>
<tr>
<td>Monday, September 24, 2018</td>
<td></td>
<td>Wednesday, September 19, 2018</td>
</tr>
<tr>
<td>Monday, October 1, 2018</td>
<td></td>
<td>Wednesday, September 26, 2018</td>
</tr>
<tr>
<td>Monday, October 8, 2018</td>
<td>Homecoming Issue</td>
<td>Wednesday, October 3, 2018</td>
</tr>
<tr>
<td>Monday, October 15, 2018</td>
<td></td>
<td>Wednesday, October 10, 2018</td>
</tr>
<tr>
<td>Monday, October 22, 2018</td>
<td></td>
<td>Wednesday, October 17, 2018</td>
</tr>
<tr>
<td>Monday, October 29, 2018</td>
<td>Apartment Pages</td>
<td>Wednesday, October 24, 2018</td>
</tr>
<tr>
<td>Monday, November 5, 2018</td>
<td>Basketball Preview</td>
<td>Wednesday, October 31, 2018</td>
</tr>
<tr>
<td>Monday, November 12, 2018</td>
<td></td>
<td>Wednesday, November 7, 2018</td>
</tr>
<tr>
<td>Monday, November 19, 2018</td>
<td>Sex in College Park</td>
<td>Wednesday, November 14, 2018</td>
</tr>
<tr>
<td>Monday, November 26, 2018</td>
<td></td>
<td>Wednesday, November 21, 2018</td>
</tr>
<tr>
<td>Monday, December 3, 2018</td>
<td>TERP HOUSING GUIDE</td>
<td>Wednesday, November 14, 2018</td>
</tr>
<tr>
<td>Monday, December 3, 2018</td>
<td></td>
<td>Wednesday, November 28, 2018</td>
</tr>
<tr>
<td>Monday, December 10, 2018</td>
<td>Special Finals Edition</td>
<td>Wednesday, December 5, 2018</td>
</tr>
</tbody>
</table>

**WINTER BREAK**

<table>
<thead>
<tr>
<th>Publication Date</th>
<th>Feature</th>
<th>Deadline</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday, January 28, 2019</td>
<td>Spring Welcome Back</td>
<td>Wednesday, January 23, 2019</td>
</tr>
<tr>
<td>Monday, February 4, 2019</td>
<td></td>
<td>Wednesday, January 30, 2019</td>
</tr>
<tr>
<td>Monday, February 11, 2019</td>
<td>Career Guide</td>
<td>Wednesday, February 6, 2019</td>
</tr>
<tr>
<td>Monday, February 18, 2019</td>
<td>Apartment Pages</td>
<td>Wednesday, February 13, 2019</td>
</tr>
<tr>
<td>Monday, February 25, 2019</td>
<td></td>
<td>Wednesday, February 20, 2019</td>
</tr>
<tr>
<td>Monday, March 4, 2019</td>
<td></td>
<td>Wednesday, February 27, 2019</td>
</tr>
<tr>
<td>Monday, March 11, 2019</td>
<td></td>
<td>Wednesday, March 6, 2019</td>
</tr>
<tr>
<td>Monday, March 18, 2019</td>
<td>MARCH MADNESS CHALLENGE</td>
<td>Monday, March 4, 2019</td>
</tr>
</tbody>
</table>

**SPRING BREAK**

<table>
<thead>
<tr>
<th>Publication Date</th>
<th>Feature</th>
<th>Deadline</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday, March 25, 2019</td>
<td>Maryland Day</td>
<td>Wednesday, March 6, 2019</td>
</tr>
<tr>
<td>Monday, April 1, 2019</td>
<td></td>
<td>Wednesday, March 27, 2019</td>
</tr>
<tr>
<td>Monday, April 8, 2019</td>
<td></td>
<td>Wednesday, April 3, 2019</td>
</tr>
<tr>
<td>Monday, April 15, 2019</td>
<td>Marijuana Issue</td>
<td>Wednesday, April 10, 2019</td>
</tr>
<tr>
<td>Monday, April 22, 2019</td>
<td>GRADUATION SPECIAL EDITION</td>
<td>Monday, April 8, 2019</td>
</tr>
<tr>
<td>Monday, April 22, 2019</td>
<td></td>
<td>Wednesday, April 17, 2019</td>
</tr>
<tr>
<td>Monday, April 29, 2019</td>
<td>Salary Guide</td>
<td>Wednesday, April 24, 2019</td>
</tr>
<tr>
<td>Monday, May 6, 2019</td>
<td></td>
<td>Wednesday, May 1, 2019</td>
</tr>
<tr>
<td>Monday, May 13, 2019</td>
<td>Special Finals Edition</td>
<td>Wednesday, May 8, 2019</td>
</tr>
</tbody>
</table>

**SUMMER BREAK**

<table>
<thead>
<tr>
<th>Publication Date</th>
<th>Feature</th>
<th>Deadline</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday, May 27, 2019</td>
<td>ORIENTATION GUIDE</td>
<td>Friday, May 3, 2019</td>
</tr>
</tbody>
</table>

### Deadlines

Newspaper deadlines are 3 business days before publication date at 4pm (Wednesdays at 4pm for all Monday publications). Tabloids are 5 columns x 10.5". Ads 9" or higher will be charged for the full column depth.
Special Sections & Products

All special sections are separate from our regular newspaper. They are either magazines or tabloid size newspapers with a variety of distribution tactics that best reach each of the sections’ designated audiences.

Basketball Spirit Papers
Spirit Papers are placed on EVERY STUDENT SEAT at the top basketball games each season!

Sex in College Park
Be in one of our most popular and well read issues! This will be distributed at all University Sex Week events throughout the year!
Publishes: November 19 • Ad Deadline: November 15

Housing Guide
Distributed on campus including dormitories. With only freshmen and sophomores living on campus, this audience needs to find somewhere off campus to live by their junior years.
Publishes: December 3 • Ad Deadline: November 14

Career Guide
What’s more important to a college student than finding a job?
Publishes: February 18 • Ad Deadline: February 13

DBK Bracket Challenge
Be a part of a HUGE Maryland tradition as student groups compete. 20,000 votes are expected in 2019.
Begins: March 11.

Terp Adventure
Be a part of one of the great student activities of the spring. Build foot traffic to your location as students compete to win prizes.
Begins: April 2.

Congratulations to the Class of 2019!
The Diamondback Congratulates the Class of 2019. Supplemental distribution at the main commencement ceremony. Ideal for graduate schools, employers and local businesses trying to reach this valuable audience.
Publishes: April 22 • Ad Deadline: April 8

Orientation Guide
Pay once to be in every single incoming freshmen and their parents’ hands at all summer orientation fairs all summer long. Gain loyal customers the first time they are on campus after their acceptance.
Publishes: May 27 • Ad Deadline: May 3
Orientation Guide

Get your message directly into the hands of all incoming students AND their parents! Your ad in the 2019 Orientation Guide will be distributed to all summer orientation visitors — 18,000 copies all for one LOW cost! Distribution directly to students & parents at every summer orientation session starting May 28.

The DBK Orientation Guide will also be available at the highest traffic locations and buildings all summer long — including the Stamp Student Union, the libraries and orientation dorms. Everyone knows that first impressions are the most important. The DBK Summer 2019 Orientation Guide enables you to reach all these new customers and their parents at precisely the right moment — when they are learning and absorbing information about UMD and College Park.

Every page and every ad is in color for no additional cost. Publishes: May 27, 2019 • Ad Deadline: May 3, 2019.

PREMIUM POSITIONS

<table>
<thead>
<tr>
<th>Positions</th>
<th>Size</th>
<th>One-Time Cost for Summer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back Cover</td>
<td>9.44&quot;x10&quot;</td>
<td>$2800</td>
</tr>
<tr>
<td>Inside Front Cover</td>
<td>9.44&quot;x10&quot;</td>
<td>$2700</td>
</tr>
<tr>
<td>Page 3</td>
<td>9.44&quot;x10&quot;</td>
<td>$2700</td>
</tr>
<tr>
<td>Center Spread</td>
<td>19.88&quot;x10&quot;</td>
<td>$4300</td>
</tr>
<tr>
<td>Pop-Up Ad</td>
<td>19.88&quot;x1.375&quot;</td>
<td>$3000</td>
</tr>
<tr>
<td>Post-It Note on Cover*</td>
<td>3&quot;x3&quot;**</td>
<td>$3000</td>
</tr>
</tbody>
</table>

*Includes Full Page Ad
**Post-Its are trimmed to 2.875"x2.875"

STANDARD POSITIONS

<table>
<thead>
<tr>
<th>Positions</th>
<th>Size</th>
<th>One-Time Cost for Summer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Page Ads</td>
<td>9.44&quot;x10&quot;</td>
<td>$2100</td>
</tr>
<tr>
<td>Half Page Ads</td>
<td>4.65&quot;x10&quot;</td>
<td>$1300</td>
</tr>
<tr>
<td>Half Page Ads</td>
<td>9.44&quot;x5&quot;</td>
<td>$1300</td>
</tr>
<tr>
<td>Quarter Page Ads</td>
<td>4.65&quot;x5&quot;</td>
<td>$800</td>
</tr>
</tbody>
</table>

AD SPECS

<table>
<thead>
<tr>
<th>Positions</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Page</td>
<td>9.44&quot; wide x 10&quot; tall</td>
</tr>
<tr>
<td>Half Page Horizontal</td>
<td>9.44&quot; wide x 5&quot; tall</td>
</tr>
<tr>
<td>Half Page Vertical</td>
<td>4.65&quot; wide x 5&quot; tall</td>
</tr>
<tr>
<td>Post-It Notes</td>
<td>3&quot; wide x 3&quot; (trimmed to 2.875&quot; x 2.875&quot;)</td>
</tr>
<tr>
<td>Coupons</td>
<td>1.788&quot; wide x 2&quot; tall</td>
</tr>
</tbody>
</table>

DEADLINES

<table>
<thead>
<tr>
<th>Positions</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publication Date</td>
<td>Monday, May 27</td>
</tr>
<tr>
<td>Space Reservations</td>
<td>Friday, May 3</td>
</tr>
<tr>
<td>Non Camera-Ready Art</td>
<td>Friday, May 3</td>
</tr>
<tr>
<td>Camera-Ready Art</td>
<td>Monday, May 6</td>
</tr>
</tbody>
</table>
Terp Housing Guide

Want to be considered one of the best off campus student housing options at the most crucial times? Have a presence online and in on campus dorms throughout the year with Terphousing! Publishes: December 3, 2018 • Ad Deadline: November 14, 2018.

Print Ads
Pay once to be placed in campus residence halls 3 times during the year. With freshmen and sophomores living on campus, this audience will soon need to find off campus housing!
Have your property listed in our Terphousing directory in a template allowing you to display photos of your property, amenities, features, contact information, leasing information and more!

<table>
<thead>
<tr>
<th>Service Type</th>
<th>Dimensions</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Page Listing or Ad</td>
<td>5”w x 8”h</td>
<td>$2,000</td>
</tr>
<tr>
<td>½ Page Listing or Ad</td>
<td>5”w x 3.9”h</td>
<td>$1,250</td>
</tr>
<tr>
<td>First Full Page Premium</td>
<td>5”w x 8”h</td>
<td>$2,300</td>
</tr>
<tr>
<td>Second Full Page Premium</td>
<td>5”w x 8”h</td>
<td>$2,300</td>
</tr>
<tr>
<td>Back Page Premium</td>
<td>5”w x 8”h</td>
<td>$2,300</td>
</tr>
</tbody>
</table>
Basketball Spirit Papers

This is your chance to be part of one of the most storied traditions of Maryland Basketball. While the Xfinity announcers introduce the opposing team’s starting players ALL of the students in the arena hold a Diamondback-produced game newspaper. While dissing the other team they will be looking at your ad during the entire introduction. The Diamondback and the Maryland Athletic Department have partnered to provide you with this unique access to these 4,000 engaged students attending B1G 10 basketball games. Certain exclusions apply. Contact your advertising representative for more info.

Full Size
21” wide x 7.5” tall
1 issue: $1,750
3 issues: $1,500

Half Size
10.5” wide x 7.5” tall
1 issue: $1,050
3 issues: $850

Quarter Size
5.1” wide x 7.5” tall
1 issue: $500

THE DIAMONDBACK
3136 SOUTH CAMPUS DINING HALL, COLLEGE PARK MD 20742 • 301-314-8000 • WWW.DBKNEWS.COM
Print • Rates

STEP 1: Choose your SIZE

Size Requirements

- Ads 16” or higher will be charged for the full column height (19.75”). Minimum ad size is 2 column inches.
- Ads sold in 0.25 inch height increments only: 1 inch, 1.25 inches, etc.
  Width measured in columns.

Placement deadline is 3 business days in advance (Wednesday at 4 PM for a Monday issue). Allow two additional days if a proof is required.

STEP 2: Choose your RATE

Standard Rate
$17.50 / column inch

New Customers
Only $8.75/column inch for 6 consecutive weeks of advertising with our Get Acquainted Program!

For just an additional $100 have 1,000 newspapers handed directly into students’ hands by our street team who will specifically mention your business and ad!

Frequency Discount Packages

Ads must run in consecutive weeks.

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Rate (column inch)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 weeks</td>
<td>$15.50</td>
</tr>
<tr>
<td>8 weeks</td>
<td>$14.50</td>
</tr>
<tr>
<td>15 weeks</td>
<td>$13.50</td>
</tr>
<tr>
<td>30 weeks</td>
<td>$10.50</td>
</tr>
</tbody>
</table>

Local Rates

- University Rate* $14.00 / column inch
- Non-Profit Rate $14.00 / column inch

*University departments, SGA groups, University clubs, fraternities & sororities.

STEP 3: Choose your COLOR & PLACEMENT

Color Options

- Grayscale
- Full Color*

Placement

A 15% upcharge is applied for placement on a specific page, when space permits.

35% upcharge for full color up to a maximum of $480

Are you interested in creating your own print ad? See the Create Your Ad section for details.
Print • Front/Back Pages Ads & Features

Front Page Advertising (Jewel Box)
A front page ad is located on the bottom-right of the front page. Available on a first-come, first-served basis.

- Full Color, 4 inches x 4 inches: $500 per week.

Back Page Advertising
Back page ads are a strip across the bottom of the back page. Available on a first-come, first-served basis.

- Full Color, 6 columns x 1.5 inches: $450 per week.
- Full Color, 6 columns x 2 inches: $600 per week ($6,000 for 16 consecutive weeks).

Features (Crossword & SuDoKu)
Possibly the most visible place in The Diamondback for your advertising message, our features page provides advertisers with the chance to sponsor the Crossword puzzle or the SuDoKu puzzle. These features are reader favorites and translate into an extremely high recall rate for your ad. Your ad will be prominently placed in a sponsored spot.

Rules
- The daily charge is $79 per issue.
- Your ad is 2 columns by 2 inches.
- First-come, first-served basis.
Print • Classifieds, Inserts, Post-Its & Posters

Classifieds
The deadline for placing display and classified ads is Wednesday at 4pm (3 business days in advance). All classified advertising must be prepaid.

Classified Display Ads
- Bold, large type, a logo or small artwork (no reversals, please).
- One column wide and sold in one inch increments (1”, 2”, 3”, etc.).
- Classified display ads are $36.00 per column inch.
- Cancellations for all ads must be given Wednesday at 4pm (3 business days in advance).

Online Bonuses
- Includes no added charge posting online to The Diamondback at DBKnews.com with an optional link to your website.

Classified Display Ads
- Headings include: EMPLOYMENT, CHILD CARE, FOR SALE, FOR RENT, ROOMMATES, SERVICES, WANTED, MISCELLANEOUS, RIDES, ADOPTIONS, PERSONALS, TRAVEL

Inserts (preprinted)
- Maximum size: 8” wide x 10” tall.
- Inserts must be at least 70 pound stock to ensure proper insertion.
- Need us to print them? Call 301.314.8000 or ask your rep for info.
- Dates for inserts must be reserved no later than one week in advance.
- Ship one week in advance of the insertion to:

  Print Innovators
  Attn: Diamondback Printing
  1381 Belman Road
  Fredericksburg, VA 22401

Newsstand Posters
Place your highly visible, full-color poster on one of our high-traffic newsstands! Posters are 19”x 36” in size.

- $350/Month/Location Supply your own posters or posters can be printed for an additional charge of $65.
- $300/Month/Location 3+ locations in one month OR one placement in 3+ consecutive months. Free poster printing included*
- $250/Month/Location 3+ locations in one month AND 3+ consecutive months. Free poster printing included*

*Additional copy changes after first month will be charged $65 per poster changed.

Subscriptions
Must be prepaid. $100 per year. All issues are mailed first-class.
Gatefold
Own The Diamondback’s print issue with our gatefold — a flap that covers 1/3 of the entire front page of the paper. When you purchase this, you get the entire front side of the flap and the back.
◆ $1,775 per issue
◆ 4” x 19.88”
◆ FREE full color!

Pop-Out
Your ad message will be visible to EVERY reader of the paper regardless of which page they are actually reading. Place your ad in the MOST visible/always visible location in the newspaper. $800 per issue when combined with any other ad in the newspaper that day
◆ $1,450 as a stand-alone ad
◆ 1.375” x 19.88”
◆ FREE full color!

Advertorial
Areas where businesses can include a description, location, and other details along with photos, logos, and more. Templates are available in InDesign format upon request.
Ask your account executive for more info.

Full Page
◆ 6 columns (10") wide x 19.88” high
◆ Black & White: $2,500
◆ Full Color: $3,000

Half Page
◆ 6 columns (10”) wide x 9.94” high
◆ Black & White: $1,250
◆ Full Color: $1,700

Quarter Page
◆ 3 columns (4.94") wide x 9.94” high
◆ Black & White: $650
◆ Full Color: $850
Street Teams Promo Squad

**Coupons and Flyers Delivered by Hand!**
Put your event flyer or coupon directly into the hands of UMD students, faculty and staff. Our talented marketing and design team can help you build dynamic and effective sales materials that WORK.

- $300 for 300 pre-printed pieces
- Other quantities available — ask for rates
- Design and printing available for an additional charge

**Bulletin Board Posters**
The Diamondback can get your message front and center in all the busiest parts of campus. Your poster or flyer will be posted where students spend the majority of their time.

- $200 for 100 flyers (printing included)
- $300 for 400 color flyers (printing included)
- Design services available for an additional charge
- Poster printing NOT included

**Sidewalk Chalking**
- Chalking: name/event, short phrase, URL (max 7 words + URL)
- Cost: $25 per chalking, up to 3-4 colors
- Size: standard 4x4 sidewalk square
- Additional words/space at additional cost

Prime Campus Locations:
- McKeldin Library (minimum 3 chalkings)
- McKeldin Library or Mall pathways (minimum 3 chalkings)
- Stamp Student Union (minimum 3 chalkings)
- South Campus Dining Hall (min. 2 chalkings)
- Hornbake Library (min. 3 chalkings)
Promo Squad Packages

Promo Squad Basic
Coupons and Flyers Delivered by Hand
• $75 per 75 flyers, sold in increments of 75
Bulletin Board Posters
• $200 for 100 boards
Sidewalk Chalking
• $25 per 4x4 square

+ Brand Ambassador Services
Wearing Branded Clothing/Gear
• Free with the supply of company brand materials for promo squad members
Handing Out Samples
• $300 for first hour of sampling, +$150 for additional hours
• Samples should be provided and extra charges may apply if additional labor is required

Promo Squad Premium
As opposed to typical hand-to-hand around campus promotion, promo squad premium is a more creative, high-volume, and high visibility effort. Reps work with you to choose a high-volume time/place during the fall semester to promote your product. These could include football games at Capital One arena, Stamp during parents weekend, career fairs, major entertainment events, etc.

• $500 + $250 for additional hours of promotion
• It is recommended that clients provide brand materials/samples to get the best exposure
Online • Mobile Rates

Space is sold in rotations, coming in increments of 5%. All rotations are run-of-site, meaning your ad is not restricted to any section of the DBKnews.com website. 1 rotation represents 5% of that space’s impressions for the month.

To create your own online ad, see the Create Your Ad section for details.
Online • Desktop Rates

Ad space is sold in rotations, which come in increments of 5%. All rotations are run-of-site, meaning your ad is not restricted to any particular section of the DBKnews.com website. 1 rotation represents 5% of that space’s impressions for the month.

728x90 • Banner A
$120 per rotation per month
1 rotation represents 5% of the ad space’s impressions for the month
SPECIAL OFFER: $200 for every 2 rotations!

300x250 • Banner B
$120 per rotation per month
1 rotation represents 5% of the ad space’s impressions for the month
SPECIAL OFFER: Free In-Story with each rotation included!

300x600 • Banner C
$75 per rotation per week
1 rotation represents 25% of the ad space’s impressions for the week
Local Customers ONLY!

250x120 • Sidekick
$450/week (includes both mobile & desktop)
Appears once every 5 minutes for each mobile and desktop visitor.
See the Online Crossplatform section for more info.

1920*300 • Desktop Billboard Takeover
*image stays centered — keep thinner browser windows in mind
$600/week
$100/day
Top-center position. Also available for mobile.
See the Online Crossplatform section for more info.

Text Links
Appear on the home page. $40 per Month
Online Crossplatform • Takeover & Sidekick

Takeovers
Takeover ads are seamlessly integrated into the middle of The Diamondback content experience. Relevant advertising is highly valued by our readers and messages appearing in these positions consistently achieve:

- **High Engagement**
  Based on the size, relevance and timing of delivery, takeover ads often gain much higher engagement than standard ads. Users are required to make a choice between the ad and continuing to the web page, as opposed to simply ignoring the ad or clicking an “X”.

- **High Conversion Rates**
  People who interact with takeover ads convert to buyers or users at higher rates relative to other online ad formats.

- **Flexible Delivery**
  Advertisers have a lot of flexibility on the timing and structure of interstitial ads. Compelling images, interactive quizzes or polls, and other creative engagement mechanisms are all possible.

**1920* x 300 • Desktop Billboard Takeover**
*image stays centered — keep thinner browser windows in mind
- 50% Rotation
- $450/week
- $100/day
- 100% Rotation
- $600/week
- $100/day

**640* x 200 • Mobile Billboard Takeover**
*image stays centered — text safe area for some devices is 450x200
- 50% Rotation
- $450/week
- $600/week
- $100/day
- 100% Rotation
- $600/week
- $100/day

**Takeover Combination**
Appears center-screen when a page loads.
- $1000/week
- or $200/day

**250x120 • Sidekick**
- $450/week (includes both mobile & desktop)
- Appears once every 5 minutes for each visitor.
Online Crossplatform • Sponsored Content

Sponsored Content

Basic Production Fee

$700

includes writing & design

FREQUENCY DISCOUNT

Add a Consecutive Week

$300

On each purchased day of sponsored content the article:

✔ Appears on the homepage within other breaking news stories
✔ Gets posted onto The Diamondback’s Facebook wall
✔ Gets included in that day’s Diamondback e-mail newsletter
✔ Includes Twitter blast to the 21,000+ followers of @thedbk
Online • Social Networks & Email

The Diamondback’s Social Media

Over 22,400  
The people following @thedbk on Twitter.

Over 8,900  
The people following facebook.com/TheDiamondback

Sponsored Tweets

◆ Tweet your message to over 22,400 followers on twitter.com/thedbk
◆ There is a limit of 280 characters per tweet. Tweets must begin with “Sponsored:“
◆ You may include links and/or hashtags. The characters of a link may differ from the total character count.
◆ $40 per tweet. You may add an image to your message. Photo must be approved by deadline.

Email Edition

Sent out to all of The Diamondback’s email subscribers!
Your ad will be featured on an email we send every day Monday–Saturday.

◆ 728x90 pixels OR 468x60 pixels.
◆ $75 per week.
Creating Your Ad

If you choose to create your own ad for The Diamondback in print or online, you will need to follow a few guidelines.

**PRINT PDF or TIF, No Bleeds**

Size: Column Width x Height

A print ad’s width is measured in “column inches” rather than regular inches. This allows ads to line up with the rest of the news content:

<table>
<thead>
<tr>
<th>1 column</th>
<th>2 columns</th>
<th>3 columns</th>
<th>4 columns</th>
<th>5 columns</th>
<th>6 columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.563”</td>
<td>3.25”</td>
<td>4.94”</td>
<td>6.625”</td>
<td>8.313”</td>
<td>10”</td>
</tr>
</tbody>
</table>

Height is measured in regular inches. So, a 2x4 ad = 3.25”x4”.

**DO NOT INCLUDE CROP MARKS OR BLEEDS IN YOUR ADS.**

The ads we receive should fit exactly to the desired ad space.

Color: CMYK

Use 100K for black areas/text, not a mix of CMYK colors to avoid blurring during the printing process. Images pulled directly from the internet will probably be in RGB, so be sure to check.

NO SPOT/PANTONE COLORS! The newspaper only uses the four plates of CMYK, so setting your file up with spot colors can cause unexpected results and errors. All your color must be in CMYK, even if the spot color you’ve chosen could be accurately reproduced with CMYK plates.

Keep your ink numbers low. Dot gain (due to the paper absorbing ink) may cause areas of heavy color concentration to become darker than intended. For this reason (and plate shifting), you should also never place small, lightly-colored text in fields of color. Even on a white background, colors used for small text should not consist of several colors. 100K is best for fine print.

Resolution: 300 pixels/inch

The newspaper prints at ~300dpi. Web ads will only be 72ppi, so when they are printed they will appear blurry/pixelated.

Save As: PDF (fonts embedded) or TIF (flattened, LZW compression)

Export/Save as a PDF. If you’re working in Photoshop, flatten all non-text and non-vector layers before export. Embed your fonts!

**ONLINE PNG or JPG or GIF**

Size: Pixels x Pixels

Online ads are measured in pixels. You ad’s file size must be under 50kb. If you don’t know how to reduce the size, send the file at full size and allow The Diamondback production staff to adjust it. You may also submit at 1.5x and/or 2x size for display on supported devices. If your file is over 50kb it may be resampled to meet requirements.

Color: RGB

You may use any colors you like, but remember that animated GIFs may require low color numbers to stay under the 50kb file size limit. Transparency in GIFs and PNGs is not supported.

Resolution: 72 pixels/inch

Anything that appears online will be at 72ppi. Photoshop will default to this if you Save For Web.

Save As: PNG, JPEG, or GIF (file size must stay under 50kb)

If you are using Photoshop, simply use File->Save for Web. You ad’s file size must be under 50kb. PNGs are larger. JPEGs are great for blended colors and gradients. GIFs are best for solid colors and will also allow some animation. If you don’t know how to reduce the file size, send the file at full size and allow The Diamondback production staff to adjust it. Print ads can usually be converted to web ads easily, but not the other way around. File size is displayed when you Save for Web.
Checking Ad Size

You may receive ads for your business through a 3rd party that get forwarded to The Diamondback. Here are two methods to check the size.

**Acrobat**

Checking Size in a PDF
Drop your ad into Adobe Acrobat. Around the edge of the window, you should see a measurement. If not, you may need to turn on Rulers:
View > Show/Hide > Rulers & Grids > Rulers

**Photoshop**

Checking Size and Resolution in a TIF/JPEG/GIF/PNG
Drop your ad into Adobe Photoshop. Go to:
Image > Image Size...

Checking Size and Resolution in a PDF
Drop your ad into Adobe Photoshop. Often with a PDF, you will be prompted with the image size panel as soon as you drop the file, and you will be able to choose an import size. If not, go to: Image > Image Size...

Remember, increasing the ad size/resolution here will not enhance the quality of the images.

**Tip**

Saving as a PDF from Photoshop after importing will NOT preserve vector elements unless the file was imported with layers intact. Any non-vector layers should be flattened before export to reduce file size.